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PENDAHULUAN

Animasi merupakan salah satu bentuk visual bergerak yang dapat dimanfaatkan untuk menjelaskan
materi pelajaran yang sulit disampaikan secara konvensional. Dengan diintergrasikan ke media lain
seperti video, presentasi, atau sebagai bahan ajar tersendiri animasi cocok untuk menjelaskan materi-
materi pelajaran yang secara langsung sulit dihadirkan di kelas atau disampaikan dalam bentuk buku.
Sebagai misal proses bekerjanya mesin mobil atau proses terjadinya tsunami.

Dengan tujuan memberi pengetahuan dasar tentang bagaimana membuat animasi kepada para
pengajar/guru modul Pembuatan Animasi dengan Adobe Flash CS3 Professional ini ditulis. Modul ini
berisi 10 kegiatan belajar yaitu:

KEGIATAN 1 : Mengenal Animasi

KEGIATAN 2 : Mengenal Adobe Flash CS2 Professional

KEGIATAN 3 : Menggambar Bentuk Dasar, Menggunakan Warna, dan Mengimpor Gambar
KEGIATAN 4 : Membuat Animasi Objek Bergerak

KEGIATAN 5 : Membuat Animasi Teks berubah Warna

KEGIATAN 6 : Membuat Animasi dengan Masking dan Path

KEGIATAN 7 : Memberi Suara pada Animasi

KEGIATAN 8 : Membuat Tombol Kontrol (play dan stop) untuk Animasi

KEGIATAN 9 : Membuat Animasi Proses Metamorfosis Kupu-Kupu

KEGIATAN 10 : Mempublish dan Mengekspor File

Setelah mengikuti kegiatan-kegiatan belajar tersebut diharapkan Anda dapat membuat animasi
sederhana dengan menggunakan Adobe Flash CS3 Professional. Dengan pengetahuan dasar
pembuatan animasi ini serta pengetahuan lain dari modul-modul pelatihan pemanfaatan ICT,
diharapkan Anda dapat mengembangkan bahan ajar yang lebih menarik dan mudah dipahami oleh

siswa.

Selamat Belajar.
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KEGIATAN 1
MENGENAL ANIMASI

TUJUAN

Setelah mengikuti kegiatan belajar ini, Anda diharapkan dapat menyebutkan:

prinsip animasi,
jenis-jenis animasi, dan

macam-macam software yang dapat digunakan dalam pembuatan animasi.

URAIAN MATERI

A. Prinsip Dasar Animasi

Animasi berasal dari kata "Animation’ yang dalam bahasa Inggris "to animate’ yang berarti
menggerakan. Jadi animasi dapat diartikan
sebagai menggerakan sesuatu (gambar atau
obyek) yang diam.

Sejarah animasi dimulai dari jaman purba, dengan
ditemukannya lukisan-lukisan pada dinding goa di
Spanyol yang menggambarkan “gerak” dari
binatang-binatang. Pada 4000 tahun yang lalu

bangsa Mesir juga mencoba menghidupkan suatu

peristiwa dengan gambar-gambar yang dibuat

berurutan pada dinding.

Sejak menyadari bahwa gambar bisa dipakai sebagai alternatif media komunikasi, timbul keinginan
menghidupkan lambang-lambang tersebut menjadi cermin ekspresi kebudayaan. Terbukti dengan
diketemukannya berbagai artefak pada peradapan Mesir Kuno 2000 sebelum masehi. Salah

satunya adalah beberapa panel yang menggambarkan aksi dua pegulat dalam berbagai pose.

Animasi sendiri tidak akan pernah berkembang tanpa ditemukannya prinsip dasar dari karakter
mata manusia vyaitu: persistance of vision (pola penglihatan yang teratur). Paul Roget, Joseph
Plateau dan Pierre Desvigenes, melalui peralatan optic yang mereka ciptakan, berhasil
membuktikan bahwa mata manusia cenderung menangkap urutan gambar-gambar pada tenggang
waktu tertentu sebagai suatu pola. Dalam perkembangannya animasi secara umum bisa
didefinisikan sebagai:

Suatu sequence gambar yang diekspos pada tenggang waktu tertentu sehingga
tercipta sebuah ilusi gambar bergerak



B. Jenis-Jenis Animasi
Dilihat dari tehnik pembuatannya animasi yang ada saat ini dapat dikategorikan menjadi 3, yaitu:
1. Animasi Stop-motion (Stop Motion Animation)
2. Animasi Tradisional ( 7raditional animation)

3. Animasi Komputer (Computer Graphics Animation)

1. Stop-motion animation
Stop-motion animation sering pula disebut claymation karena dalam perkembangannya, jenis
animasi ini sering menggunakan clay (tanah liat) sebagai objek yang digerakkan . Tehnik stop-
motion animation merupakan animasi yang dihasilkan dari penggambilan gambar berupa obyek
(boneka atau yang lainnya) yang digerakkan setahap demi setahap. Dalam pengerjaannya

teknik ini memiliki tingkat kesulitan dan memerlukan kesabaran yang tinggi.

. "Lgd i
Salah satu adegan dari film Celebrity Deadmatch.

L / o

Salah satu adegan dari film Chiken Run.
Wallace and Gromit dan Chicken Run , karya Nick Parks, merupakan salah satu contoh
karya stop motion animation. Contoh lainnya adalah Celebrity Deadmatch di MTV yang

menyajikan adegan perkelahian antara berbagai selebriti dunia.

2. Animasi Tradisional (Traditional animation)
Tradisional animasi adalah tehnik animasi yang paling umum dikenal sampai saat ini.
Dinamakan tradisional karena tehnik animasi inilah yang digunakan pada saat animasi pertama
kali dikembangkan. Tradisional animasi juga sering disebut ce/ animation karena tehnik
pengerjaannya dilakukan pada celluloid transparent yang sekilas mirip sekali dengan
transparansi OHP yang sering kita gunakan. Pada pembuatan animasi tradisional, setiap tahap
gerakan digambar satu persatu di atas cel.
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Contoh gambar proses gerakan berjalan pada animasi tradisional.

Dengan berkembangnya teknologi komputer, pembuatan animasi tradisional ini telah dikerjakan
dengan menggunakan komputer. Dewasa ini teknik pembuatan animasi tradisional yang dibuat

dengan menggunakan komputer lebih dikenal dengan istilah animasi 2 Dimensi.

Dengan berkembangnya teknologi
komputer, pembuatan animasi tradisional
ini telah dikerjakan dengan menggunakan
komputer. Dewasa ini teknik pembuatan
animasi tradisional yang dibuat dengan
menggunakan komputer lebih dikenal

dengan istilah animasi 2 Dimensi.

Pinokio” sa/ah satu film animasi tradisional buatan

Waltsdisney.

"Naruto” salah satu film animasi

_ tradisional yang proses pembuatannya
\ telah menggunakan komputer.

N



3. Animasi Komputer
Sesuai dengan namanya, animasi ini secara keseluruhan dikerjakan dengan menggunakan
komputer. Dari pembuatan karakter, mengatur gerakkan “pemain” dan kamera, pemberian
suara, serta special effeknya semuanya di kerjakan dengan komputer.
Dengan animasi komputer, hal-hal yang awalnya tidak mungkin digambarkan dengan animasi
menjadi mungkin dan lebih mudah. Sebagai contoh perjalanan wahana ruang angkasa ke suatu

planet dapat digambarkan secara jelas, atau proses terjadinya tsunami.

Monster Inc,a/ satu film animasi yang seluruh pembuatannya menggunakan komputer.
Perkembangan teknologi komputer saat ini, memungkinkan orang dengan mudah membuat

animasi. Animasi yang dihasilkan tergantung keahlian yang dimiliki dan software yang

digunakan.

Salah satu contoh animasi untuk dunia

pengetahuan yang dibuat dengan komputer.




C. Software Animasi
Saat ini terdapat banyak jenis software animasi yang beredar di pasaran, dari software yang
mempunyai kemampuan yang sederhana hingga yang komplek, dari yang gratis hingga puluhan
juta rupiah.
Dari sisi fungsi penggunaan software animasi dapat dikelompokkan menjadi Software Animasi 2

Dimensi dan Software Animasi 3 Dimensi.

1. Software Animasi 2 Dimensi.

Software animasi 2D adalah software yang
digunakan untuk membuat animasi
tradisional (flat animation), umumnya
mempunyai kemampuan untuk
menggambar, mengatur gerak, mengatur
waktu, beberapa dapat mengimpor suara.
Dari sisi penggunaan umumnya tidak sulit.

Contoh dari Software Animasi 2D ini antara

lain:

e Macromedia Flash ‘ T;a'/;7p//;3n Jjendela ‘kerj; ?oonBa'om Studio
e Macromedia Director

e ToonBoom Studio

e Adobe ImageReady

e Corel RaVe

e Swish Max

o Adobe After Effect

2. Software Animasi 3 Dimensi

Software animasi 3D mempunyai fasilitas dan kemampuan yang canggih untuk membuat
animasi 3 dimensi. Fasilitas dan kemampuan tersebut antara lain, membuat obyek 3D,
pengaturan gerak kamera, pemberian efek, import video dan suara, serta masih banyak lagi.
Beberapa software animasi 3D mempunyai kemampuan khusus, misalnya untuk animasi
figure(manusia), animasi landscape (pemandangan), animasi title (judul), dIl. Karena
kemampuannya yang canggih, dalam penggunaannya diperlukan pengetahuan yang cukup
tinggi dan terkadang rumit.



Contoh dari Software Animasi 3D ini antara
lain:

¢ 3D Studio Max

e Maya

e Poser (figure animation)

e Bryce (/andscape animation)

e Vue (/andscape animation)

e Cinema 4D

e Blender (gratis)

e Daz3D (gratis)

T e ey, ([D— | ——

Tampilan jendela kerja Daz3D

‘[( v

I:Tmu-.-e s s o - o ]
| 300 | [ [e0oa | am T a3 @k _ - | sub_in_watar
| || v e - 30 St SRR I 480 x 64

St it

#0-00:00.00 - R ASALA i

Tampilan jendela kerja 3D Studio Max Té/-n‘pﬂan Jjendela kerja Bryce

Fie Edi Fges (Byect Daplay flende Arsmsion Windew Soph Hep

Tampilan jendela kerja Poser
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TUJUAN
Setelah mengikuti kegiatan belajar ini, Anda diharapkan dapat menyebutkan:
e cara membuka program Adobe Flash CS3 Professional, dan

¢ bagian-bagian jendela kerja Adobe Flash CS3 Professional.

URAIAN MATERI

Adobe Flash CS3 Professional, merupakan software yang dirancang untuk - membuat animasi berbasis
vektor dengan hasil yang mempunyai ukuran yang kecil. Awalnya software ini memang diarahkan
untuk membuat animasi atau aplikasi berbasis internet (online). Tetapi pada perkembangannya
banyak digunakan untuk membuat animasi atau aplikasi yang bukan berbasis internet (offline).
Dengan Actionscript 3.0 yang dibawanya, Adobe Flash CS3 Professional dapat digunakan untuk
mengembangkan game atau bahan ajar seperti kuis atau simulasi. Contoh dari game atau bahan ajar

dapat Anda lihat di www.e-dukasi.net atau pada Pesona Edukasi.

Dari pengalaman penulis menjadi juri di Lomba Pengembangan Bahan Ajar Interaktif untuk SMA yang
diadakan oleh Depdiknas, banyak karya bagus yang dibuat oleh peserta (guru) dengan menggunakan
software Adobe Flash CS3 Professional.

Penggunaan Adobe Flash CS3 Professional untuk animasi atau pembuatan bahan ajar interaktif
tidaklah sulit, tool-tool yang tersedia cukup mudah digunakan, beberapa template dan component
juga sudah disediakan dan siap digunakan.

Dengan anggapan software Adobe Flash CS3 Professional telah terinstal pada komputer yang Anda

gunakan, berikut ini langkah awal untuk mengenal penggunaan Adobe Flash CS3 Professional.

A. Cara Membuka
Untuk membuka program Adobe Flash CS3 Professional, Anda dapat melakukan salah satu cara
berikut:

Fl
&

¢ Klik icon Adobe Flash CS3 Professional Adobe Flssh pada dekstop (Layar monitor).

Professional

e Klik Start Menu - All Programs - Adobe Master Collection CS3 - Adobe Flash CS3
Professional.

Beberapa saat akan muncul jendela dialog seperti berikut.
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G Adobe Flash 53 Professional o NN, NN 00— | E i

File Edit Commands Control Window Help

[ Color x | Swatches

FL

ADOBE® FLASH® CS3 PROFESSIONAL

Open a Recent ltem Create New Create from Template

P Flash File (ActionScript 2.0) T Advertising
P Flash Fiie (ActionScript 2.0) T 5ReW Handsets

T Flash Fie (Mobie) T consumer Devices
T ActonScript File T Gioval Handsets
=T ActionScript Communication File P Japanese Handsets
I Flash JavaScript File £3 More.

= Flash Project
Extend

@ Flash Exchange »

] Getting Started » Get the most out of Flash
[C] new Features » [SIl Find reouiary upaated tips, techniques,

podcasts, interviews, and more in Adobe Bridge

[C] Resources » Home by choosing File » Browse.

[ Dontshow again

| < Froperties x | Filters | Parameters

Pilih Create New - Flash File (ActionScript 2.0) untuk memulai membuat file baru.

Pilih Open a Recent New - Open untuk membuka file flash.

B. Mengenal Jendela Kerja
1. Mengenal Menu Dasar
Berikut merupakan tampilan standar jendela kerja Adobe Flash CS3 Professional, saat Anda

memulai membuat file baru.

(G Adobe Flash CS3 Professional - untitied 1 . NN B W WS . ol
File Edit View Insert Modify Tex Commands Centrol Debug Window Help €—— MJENUBAR

5 0 15 20 25 30 35 4 45 S0 S5 & 65 W 75 80 85 90 95 szJ Color x | Swatches |
om

4 TIMELINE L
4T LAYERS LYl
N a, R0 [ b
27 flasaa it m® W 1 mofe o005 ¢ = v ‘; -Z:-S—B
@ & dI ‘ é Scene 1 Waorkspace ¥ év ‘&. 65% Alpha:  100% B  £0033FF
r 7 A
=N L
/.
:k.:’-J | Library x -.%
PANEL w ®
STAGE Empty library
Name Type i
o
WORKING AREA U 3 I
g I i ' o
= Properties x | Filters | Parameters | _,%
m e = e [l Geeee [ @
Untitied-1 Publish: Player: 9 ActionScript: 3.0  Profile: Default
Document dass: &# e 3
PROPERTIES PANEL Jome & mm b

Jendela kerja aplikasi Adobe Flash CS3



Jendela kerja Flash 8 terdiri atas :

Menubar

11

Berisi kumpulan menu atau perintah-perintah yang digunakan dalam Adobe Flash CS3.

File

Toolbar

Edit  View

Insert Modify Text Commands

Control

Menubar pada aplikasi Adobe Flash CS3

Debug Window Help

Toolbar merupakan panel berisi berbagai macam tool. Tool-tool tersebut dikelompokkan

menjadi empat kelompok: Tools; berisi tombol-tombol untuk membuat dan mengedit

gambar, View; untuk mengatur tampilan lembar kerja, Colors; menentukan warna yang

dipakai saat mengedit, Option; alat bantu lain untuk mengedit gambar.

Tool Nama Fungsi Shortcut
_ lt Selection Tool Memilih dan memindahkan objek \Y
Subselection Mengubah bentuk objek dengan
Rk % Ny A
Tool edit points
KT %1 Free Transform | Mengubah ukuran atau memutar
< P A Tool bentuk objek sesuai keinginan Q
— Gradient .
}',) ] T N} Transform Tool Mengubah warna gradasi F
‘\ [ Menyeleksi bagian objek yang
! &' | Lasso Tool akan diedit L
j _gV Membuat bentuk objek secara
&J Pen Tool bebas berupa dengan titik-titik P
i @:, sebagai penghubung
/g A7 T Text Tool Membuat teks (kata atau kalimat) T
o M Line Tool Membuat Garis N
X . .
Membuat objek berbentuk segi
[ | Rectangle Tool . R
¥ ! - empat atau segi banyak
Q@ Oval Tool Membuat objek elips atau 0
&y [ | lingkaran
m j’ Pencil Tool Menggambar objek secara bebas Y
[E;] ] Menggambar objek secara bebas
ol v Brush Tool dengan ukuran ketebalan dan B
bentuk yang sudah disediakan
Memberi warna garis tepi
#% | Ink Bottle Tool (outline) S
& Paint Bucket Memberi warna pada objek secara K
Tool bebas
f Eyedropper Tool | Mengambil contoh warna I
ey Eraser Tool Menghapus objek E
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Tool Nama Fungsi Shortcut

£ Hand Tool Menggeser Stage H

Memperbesar atau memperkecil

tampilan objek atau stage
Memberi atau memilih warna

- I | Stroke Color ri atall memiin war
untuk garis tepi

L | Zoom Tool M atau Z

<+ I | Fill Color Memberi warna pada objek

. Mengatur fungsi tambahan pada
Option Tool tool yang sedang aktif

Timeline

Timeline atau garis waktu merupakan komponen yang digunakan untuk mengatur atau
mengontrol jalannya animasi. Timeline terdiri dari beberapa layer. Layer digunakan untuk
menempatkan satu atau beberapa objek dalam stage agar dapat diolah dengan objek lain.
Setiap layer terdiri dari frame-frame yang digunakan untuk mengatur kecepatan animasi.

Semakin panjang frame dalam layer, maka semakin lama animasi akan berjalan.

- DEI 3 10 15 20 25 30 35 40
Al Layer 3 e o [] |:||D|
Al Layer 2 | |:||D|
| M yer: ] e

Stage
Stage disebut juga layar atau panggung. Stage digunakan untuk memainkan objek-objek
yang akan diberi animasi. Dalam stage kita dapat membuat gambar, teks, memberi warna

dan lain-lain.

Panel T
Beberapa panel penting dalam Adobe Flash CS3 Professional,

Hij

| Color x | Swatches | .

sW el o

diantaranya panel: Properties, Filters & Parameters, Actions,

ol
Library, Color dan Align & Info & Transform " A8
. R: O
Actionscript 1.0 &2.0 | PO EERERE YO B % <
[E] Global Functions - on (release) {gotoAndPlay(4): B: 255 |v|

Mavie Clip Control

E] Timeline Control ‘ H
@ gotoandPlay |=

@ nextFrame ‘

[ | T J,

Apha: 100% [v|  #0033FF
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d Propertles | & Properties X |_Fi|ters ] Parameters

Panel Prope[‘t]es akan Fl Document Size: Background: R Framerate: 12 fps
) Untitled-1 Publish: Flayer: 9 ActionScript: 3.0 Profile: Default
berubah tampilan dan
Document dass: _?’

fungsinya  mengikuti

bagian mana yang sedang diaktifkan. Misalnya Anda sedang mengaktifkan Line tool, maka
yang muncul pada jendela properties adalah fungsi-fungsi untuk mengatur line/garis seperti

besarnya garis, bentuk garis, dan warna garis.

e Library
. . . . | Library - Buttons.fa x |

Panel Library mempunyai fungsi sebagai perpustakaan . 577 items
simbol/media yang digunakan dalam animasi yang sedang

dibuat. Simbol merupakan kumpulan gambar baik movie, tombol

(button), sound, dan gambar statis (graphic).

Narne B
[ playsack flat =]
[Z* playsack rounded

2. Document Properties
Fungsi Document Properties adalah untuk melakukan pengaturan ukuran layar, warna
background, framerate, dan dimensi dari animasi yang akan dibuat. Untuk memanggil kotak

dialog Document Properties, pilih jendela Properties di bawah layar, kemudian pilih tombol Size.

| % Properties x |_Fi\ters I Parameters
F{ Document Size: 550 x 400 pixels Background: A Frame rate; 12 fpos
Untitled-1 Publish: Flayer: 9 ActionScript: 3.0 Proflle: Default
Document dass: f
F b

Judul dan deskripsi yang akan dimasuk-
kan ke dalam metadata output. Bukan

merupakan penamaan file, jadi tidak ada [~
masalah bila tidak diisi.

Document Properties

Title:

- - Description:
Dimensi atau ukuran stage yang =

diinginkan. ,

[Dr::criptinn put

Pilihan Printer memaksimalkan ukuran

movie hingga area cetak penuh. Karena 550 px (width) x 400 px (height)
output yang diinginkan berupa animasi  f———_|

dan bukan print-out maka pilihan yang - ~) Printer Contents @) Default
diaktifkan adalah Default
.

Klik dan pilihlah warna yang tersedia A (Frame rates | 12 fos ]
untuk mengubah wama stage —area | -

Pastikan satuan yang aktif adalah

A
Pixel Karena satuan inilah yang akan [ Ok

digunakan.

L —

[ Cancel

Framerate yaitu kecepatan Flash
dalam memutar animasi secara utuh
yang diukur dalam fps (frame per
second). Semakin besar framerate
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KEGIATAN 3
MENGGAMBAR BENTUK DASAR,
MENGGUNAKAN WARNA, DAN MENGIMPOR GAMBAR

TUJUAN

Setelah mengikuti kegiatan belajar ini, Anda diharapkan dapat menggunakan tool-tool pada Adobe
Flash CS3 Professional untuk:

e Menggambar bentuk-bentuk dasar (garis, kotak, lingkaran atau oval, dan bentuk bebas),

e Mewarnai objek,

e Mengolah teks, dan

e Mengimport gambar.

URAIAN MATERI
A. Menggambar Bentuk-bentuk Dasar

1. Membuat garis dengan Line Tool

Flash menyediakan pilihan untuk membuat

beragam bentuk garis. Pilih ikon Line Tool

8T
(\) pada toolbar di sisi kiri layar, kemudian {[>\]=
7 &

e | ¢ @H B[] 1 120fps 00s 4
lihat pilihannya di panel Properties di sebelah | ¢ & | & scene:
kii  bawah layar, Masukkan - angka ’;i
L
ketebalannya. Dan untuk memulai garis klik
Y

pada stage dan drag sepanjang yang anda |[w== /
— =l
inginkan.
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2. Membuat garis dengan Pencil Tool

Untuk membuat garis bebas, Pilih ikon Pencil
Tool () pada toolbar sisi kiri dan pilih
warnanya pada panel Colors di bawahnya.
Untuk membuat garis

lurus, pada panel

Options di bawah {foolbar pilihlah opsi
Straighten, untuk garis lengkung yang halus
pilih Smooth dan untuk membuat garis sesuai

dengan gerakan mouse pilih Ink.

. Menggambar lingkaran atau elips

Pilih Oval Tool ('©.) untuk menggambar
bentuk lingkaran atau elips. Untuk memulai
menggambar, klik pada stage dan drag sebesar
lingkaran atau oval yang Anda inginkan.
Adapun jenis dan warna garis serta sisi bentuk

itu dapat dipilih pada panel Colors.

. Menggambar kotak
Pilih Rectangle Tool () untuk meng-
bentuk kotak pada Untuk

memulai menggambar, klik pada stage dan

gambar layar.

drag sebesar kotak yang Anda inginkan.
Adapun jenis dan warna garis serta warna isi
(fill) bentuk itu dapat dipilih pada panel

Colors.

16
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4. T
N &
2]+ fa-
& &
* P

EETEE: |
A Seene 1

{ WH W [ 1 120fps 00s < [

&9

bl |

w
o[s]

Rectangle Tool (R)

=
v owiTool (0) Bm W[ 1 120fs 00s <[

P
o] I Rectangle Primitive Tool (R}
Fa

o

2 Oval Primitive Tool (0)

O PolyStar Tool

| Untitled-17 |

EEaTEN: |

@& LI!II %Stenel

f mH W[ 1 120fps 00s o« [
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Apabila Anda ingin bentuk sudut kotak tidak berbentuk lancip tetapi berupa sudut yang halus
(lengkung), Anda dapat mengubahnya dengan cara pilih Rectangle Tool ('“.) dan rubah nilai
yang ada pada panel Properties dan masukkan nilai 10 seperti yang ¢ 10 H i N w
ditunjukkan pada gambar di samping. Lalu mulailah menggambar ‘- *° Jw

kotak dan hasilnya akan terlihat.

| Untitled-1* |
= @ 0 5 10 15 20 25 30 35 40 45 50 55

LI
L

\
3?” rd &8 3@ 8§ { W't W [1 1 120fps 005« [ m

(3 & Ll'f[: % Scene 1

om S

4

. SB[ (G o,
Toal & = I:‘Strake hinting Scale: Miter:| 3 Join:
w0 YT
H 4

|0 |0 Reset

5. Menggambar bentuk bersegi banyak
Untuk menggambar bentuk bersegi banyak, Klik
dan tahan pada Rectangle tool (), kemudian
pilih PolyStar tool ( ©.).

Untuk memilih bentuk bersegi banyak atau bintang,

Pilih Options pada panel Properties, Kemudian

pada jendela dialog Tool Settings yang muncul

Anda dapat memilih bentuk yang diinginkan serta

|+ Propertis | filtess | Parameters

i : e | O
dapat mengisikan angka berapa segi banyak yang .
akan dibuat.
Tool Settings Untuk menggambarnya, Klik mouse pada stage kemudian drag sesuai
Style: polygon __~ besarnya objek yang diperlukan.

Humber of Sides: :i.arﬂ :

Star peint size: (.50

ok | [eenei]




6. Menggambar bentuk bebas atau unik

Untuk membuat bentuk bebas atau unik Anda
dapat menggunakan Pen Tool (%.). Klik
mouse pada stage, drag dan lepas, maka garis
akan terbentuk. Gerakkan kembali mouse ke
arah yang diinginkan dklik untuk membuat
sudut atau anchor point. Bila bentuknya
merupakan kurva tertutup maka dapat diberi

warna.

. Mengubah Ukuran Objek

Pilih Selection Tool (* ) klik dua kali pada
gambar/objek yang akan diubah ukurannya.
Pilih Free Transform Tool (*.), maka pada
ujung bentuk akan muncul kotak kecil atau
handle. Pada panel Option pilih opsi Scale
(). Klik pada salah satu titik kemudian drag
kotak kecil tersebut ke arah luar, ukuran akan
membesar dan drag ke arah dalam' maka

ukuran akan mengecil.

8. Memutar Objek

Pilih Selection Tool () klik dua kali pada
gambar/objek yang akan diputar. Pilih Free
Transform Tool (*.), maka pada ujung
bentuk akan muncul kotak kecil atau Aandle.
Pada panel Option pilih opsi Rotate and
Skew () pada panel Option kemudian
arahkan mouse mendekati salah satu handle
yang ada di sudut hingga cursor membentuk
panah melingkar. Klik dan drag ke arah
putaran yang diinginkan.

18
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B. Menggunakan Warna
1. Mengganti Warna
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Untuk mengganti warna isi atau garis dari bentuk
yang telah dibuat dapat dilakukan dengan
menyeleksi/memilih bentuk yang akan diganti

dengan menggunakan  Selection Tool (*).
Double-klik gambar yang ingin diganti warnanya,
kemudian pada panel Colors pilih opsi Stroke
(7®) Klk dan

Color pilih  warna untuk

mengubah warna garis atau pilih Fill Color ( ** ™)
Klik dan pilih warna untuk mengubah warna isi
bentuk.

. Gradasi

Untuk memberi warna gradasi bada suatu
gambar/objek, pilih menu Window - Color
Mixer, jendela Color Mixer akan muncul di
sebelah kanan layar. Pilih gambar/objek yang

akan diberi warna gradasi dengan Selection
Tool (*), pada pull-down menu di panel Color
Mixer, pilih Type Radial. Pilih warna yang lebih
terang untuk bagian sebelah kiri, sedangkan

bagian kanan yang lebih gelap.

| Latihan 8* | Untitled3* |

Al o g

¢ W % [ 1 120fps 005«

% Scene 1

& &

LAEN

LN

[l

— —x
@ 65 M 75 8 85 90 <-= color SRS =
Aow ol

B am Overflow: i -

s [ Linear RGE

R0 [
S G: 255 4
t B: 255 .
Workspace £, <, 100% "W cha: won [1] sooree

o V|

=] ]
[ [#00ccer Aph:[100% [« @)

Untuk mengedit

yang muncul

gradasi pilih Gradient

Transform Tool (). Klik dan drag handle

sesuai dengan arah vyang

diinginkan.
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C. Mengimpor Gambar dan Mengolahnya
1. Mengimpor Gambar
Untuk memasukkan gambar dalam format bitmap, seperti misalnya foto, ke dalam movie dapat
dilakukan dengan cara mengimpor gambar/foto tersebut. Pilih menu File > Import -

Import to Stage, lalu cari letaknya direktori gambar yang akan diimpor.

Adobe Flash C53 Professional - [Untitled-3%] - = -

Edit View Inset Modify Text Commands Control Debug Window Help
MNew... Ctrl+ M
Open... Ctrl+0
Browse... Ctrl+Alt+ O u

Open from Site...

Open Recent 3
Close Ctrl+W
Close All Ctri+Alt+W

Save Ctrl+5 |4 @ B[] 1 120fps 008 < :
Save and Compact

Save As... Ctrl+Shift+5
Save as Template...

CheckIn...

Save All

Revert

Import 3 Import to Stage... Ctrl+R

Export 3 Import to Library...

Publich Settings... Cirle Shift+F12 Open External Library... Ctrl+Shift+0

Publish Preview » Import Vides...

2. Memperbesar/memperkecil
Untuk memperbesar atau memperkecil ukuran gambar dapat dilakukan dengan menggunakan
Scale Tool () pada toolbar disebelah kiri. Agar ukuran gambar tidak distorsi, tekan Shift

pada keyboard pada saat memperbesar/memperkecil gambar.

| Latihan & | Untitled-3* |
i ®and

B @ @ (b B W[ 1 120fps 005 <[

& & Lm £ Scene 1
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3. Mengubah Bitmap menjadi Vektor (Trace Bitmap)
Dalam Flash terdapat fasilitas untuk mengubah gambar dalam format bitmap menjadi vekior,
yaitu menu Trace Bitmap. Fasilitas ini berguna untuk mengurangi besarnya file karena
penggunaan gambar bitmap dalam animasi. Namun tentunya kualitas gambar bitrmap itu sendiri
akan mengalami penurunan.
Untuk mengaplikasi Trace Bitmap pada gambar/foto yang telah kita impor, sebelumnya
pilih/seleksi terlebih dulu gambarnya menggunakan Selection Tool ( * ) pada toolbar.
Kemudian pilih menu Modify > Bitmap -> Trace Bitmap

Adobe Flash C53 Professional - [Untitled-3%] T .
File Edit View Insert | Modify | Tet Commands Control Debug Window Help

Document... Ctrl+)
Convert to Symbol... Fa 20 25 30 35
Break Apart Ctrl+B
Bitmap 3 Swap Bitmap...
Symbol 4 Trace Bitmap...
Shape 3
Cormbine Objects 4
120fps 005 <« [

Timeline 3
Timeline Effects 3
Transform 3

—
Arrange [3
Align 3 L
Group Ctrl+G
Ungroup Ctrl+Shift+G

Setelah muncul kotak dialog Trace Bitmap, Trace Bitmap ———
masukkan angka pada kolom Color Threshold -
9 P Color threshold:
dan Minimum Area. Semakin besar angka yan
g y g Minimum area: 100 pixels
dimasukkan semakin besar pula file yang curve it
Curve fit: s

dikompres. Namun sebaiknya tidak memasukkan l Comer thredhold:

1
m
m

angka lebih kecil dari 10 (sepuluh) karena

pengaruhnya pada pengurangan besarnya file sebagai tujuan utama Trace Bitmap akan
sangat kecil. Bahkan pada beberapa komputer (dengan spesifikasi rendah) akan mengakibatkan

hang, karena komputer dipaksa bekerja terlalu keras untuk menguraikan gambar tersebut.

Setelah proses Tracing Bitmap selesai, @ icobe flosh 53 Profesional - Unied 3T ML S e——

File Edit View Insert | Modify | Text Commands Control Debug Window Help

pilih menu Modify -> Group, agar Recument: e
Convert to Symbaol... F& 20 25 30 35

gambar yang sudah di-trace tersebut Break Apart Cirl+B

. . Bitmap 3

terkumpul sebagai satu image. Symbol b

N ’J_ Shape . 4

Combine Objects 3
& F TR 120fps 0.0s «[___m

Timeline 4

@ & le E Timeline Effects 4

F a

- Transform 4

tﬂp \1 Arrange [

IR o Align 3

S| Group Ctrl+G

LR v Ungroup Ctrl+Shift+G
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4. Pengolahan Gambar lebih lanjut
Untuk mendapatkan gambar dengan hasil olahan lebih lanjut, disarankan untuk menggunakan
software lain yang memang dikhususkan untuk mengolah gambar/foto, seperti; Macromedia
Fireworks, Adobe Photoshop atau Corel Photopaint. Adobe Flash CS3 Professional

digunakan pada saat gambar tersebut telah siap untuk dianimasikan.



KEGIATAN 4
MEMBUAT ANIMASI OBJEK BERGERAK



KEGIATAN 4
MEMBUAT ANIMASI OBJEK BERGERAK

TUJUAN

Setelah mengikuti kegiatan belajar ini, Anda diharapkan dapat membuat:
¢ Animasi objek bergerak dengan pergeseran tempat

e Animasi objek bergerak membesar atau mengecil

e Animasi objek bergerak dengan berputar

e Animasi perubahan bentuk.

URAIAN MATERI
A. Animasi Gerak dengan Pergeseran Tempat
Untuk membuat animasi sebuah objek yang dapat bergerak/ bergeser dari suatu tempat ke tempat
lain (ke samping, ke atas, ke bawah dan sebagainya) langkah-langkahnya sebagai berikut:
1. Setelah membuat file baru, pilih Oval tool ( ©.) pada toolbar (atau tool yang lain sesuai bentuk
objek yang akan dibuat).

2. Buat sebuah lingkaran pada layar kerja.

3. Pilih Selection tool ( * ), kemudian klik dua kali pada lingkaran untuk mengaktifkan lingkaran.
4. Pilih Modify > Convert to symbol

I Adobe Flash CS3 Professional - [Untitled-47] | -

File Edit View Insert | Modify | Text Commands Control Debug  Window
——

[ Untitiea4* | Document... Ctrl+)
e Convert to Symbol... Fa 20
Break Apart Ctrl+B

5. Pada kotak dialog yang tampil isikan seperti berikut:

[ |
Convert to Symbol @
MName:  lingkaran oK
Type: () Movie dip Registration: Cancel
_) Button ol
@) Graphic ——————
Advanced
L
6. Pilih OK

24
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7. Klik mouse di frame 30 pada Timeline, kemudian pilih Insert > Timeline > Keyframe atau

Klik kanan mouse pilih Insert Keyframe.

sh C53 Professional - [Untitled-4%] - - |l — -

—

iew Inset Modify Text Commands Control Debug Window Help

| Untitled-4+ |
H = a [ 5 10 15 20 25
™ Layeri1 s+« H

a0 ]
L -

o B [l 1 120fps  0.0s

35 40 45

50 55 &0

Create Motion Tween

Create Shape Tween

Insert Frame

Remove Frames

Insert Keyframe

8. Klik mouse pada lingkaran, kemudian geser lingkaran ke sembarang tempat (sebagai contoh di

sini digeser ke arah kanan)

-

9. Blok pada Timeline dari frame 1 hingga frame 30.

10.Pilih jendela Properties, pada pilihan Tween pilih Motion.

J % Properties X |_Fi|ters l Parameters [

| :

=z one
Shape

Atau

Sound: lNone

Effect: | None

Sync: ’Event

- ] ’Repeat

Mo sound selected

Klik kanan mouse pada Timeline pilih Create Motion tween

| untitled-2* |
i @i s 10 15 20

™M layerl ~# + + B

35 40

45 50 353 60

Create Motion Tween

Create Shape Tween

Insert Frame

Remove Frames

Sekarang coba jalankan animasinya dengan cara pilih Control > Play atau tekan Enter pada

keyboard
Catatan :

Anda dapat merubah gerakan awal dan akhir dengan cara:

Klik mouse pada frame 1 (untuk awal gerakan) kemudian ubah letak lingkaran pada layar, dan

kiik mouse pada frame 30 (untuk akhir gerakan) kemudian ubah letak lingkaran.

Untuk mempercepat gerakan animasi geser keyframe akhir ke kiri (<30) dan untuk

memperlambat geser ke kanan (>30).
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B. Animasi Gerak dengan Pembesaran atau Pengecilan Bentuk
Untuk membuat animasi gerak dengan pembesaran atau pengecilan bentuk, lakukan langkah yang
sama dengan pembuatan animasi pergeseran tempat hingga langkah ke 10.
1. Kemudian klik frame 30 pada Timeline.
2. Pilih Free Transform Tool (*i) , arahkan kursor ke salah satu titik sudut yang muncul di
gambar lingkaran. Sambil menekan tombol Shift pada keyboard, Klik mouse pada titik tersebut

dan geser ke arah luar hingga lingkaran membesar. Kemudian lepaskan mouse.
Jalankan animasi dengan menekan tombol Enter.
Catatan:

Untuk membuat objek mengecil, saat menggeser sebuah titik pada

lingkaran arahkan ke dalam hingga lingkaran mengecil.

C. Animasi Gerak dengan berputar
Untuk membuat animasi gerak dengan berputar, lakukan langkah yang sama dengan pembuatan

animasi pergeseran tempat hingga langkah ke 10.

1. Pilih Selection tool (), kemudian klik dua kali pada lingkaran atau klik kanan mouse pada
lingkaran, pilih Edit in Place.

Copy Motion
Copy Motion as ActionScript 3.0...
Paste Motion

Paste Motion Special...

Select All
Deselect All

Free Transform

Arrange 3

Break Apart

Distribute to Layers

Edit
Edit in Place
Edit in New Window

2. Pilih Paint Bucket Tool (&)
3. Pilih Window > Color Mixer
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4. Pada jendela Color Mixer pilih Radial pada pilihan Type

— . - X
| Colorx | Swatches | -—

20 wefsd ]

Mone

& Solid
a Linear
L]+

Bitmap

(]
&
KE|KE KN

Apha: 100% [v| ~#0099FF

5. Kemudian arahkan kursor ke lingkaran (jangan ditengah-tengah) dan klik mouse.
Catatan.

Langkah di atas bertujuan agar saat lingkaran diputar terfihat gerakkannya.

6. Tutup jendela lingkaran dan kembali ke jendela Scene 1 dengan cara klik pada tab Scene 1.
| ¢
7. Kemudian klik frame 30 pada Timeline.

8. Pilih Modify > Transform -> Rotate and Scale

= Scene1 HA Lingkaran

9. Pada jendela Scale and Rotate isi kolom Rotate dengan 180 (angka ini menunjukkan berapa
derajat objek akan berputar)
10.Pilih OK
Jalankan animasi
Catatan:
Untuk membuat animasi yang dapat bergerak berputar sambil membesar atau mengecil, Anda

dapat mengisikan nilai Scale dan Rotate secara bersamaan pada jendela Scale and Rotate.

. Animasi Perubahan Bentuk

1. Buat sebuah file baru.

2. Dengan menggunakan Oval Tool ( ©.) buatlah sebuah bentuk ova/.

3. Klik di frame 40 pada timeline, klik kanan mouse pilih Insert Blank Keyframe.

| untitled-5* |
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4. Di posisi frame ke-40, buatlah sebuah persegi.

5. Klik mouse pada bagian tengah timeline, pilih jendela Properties, pada opsi Tween pilih
Shape.
6. Jalankan animasi.

Untuk memperoleh animasi yang gerakannya lebih teratur, dapat digunakan Shape Hints.
Sebagai contoh dapat dipraktekkan pada animasi yang baru saja kita buat.

1. Klik mouse pada frame pertama.

| untitled-5* |

2. Pilih Modify > Shape > Add Shape Hint, akan muncul bulatan kecil berwarna merah.

3. Ulangi sebanyak tiga kali kemudian drag masing-masing titik a, b, ¢, d sesuai gambar.

4, Klik mouse pada frame terakhir.

| Untitled-5+ |

8“5 @E & |4 e B[] 40 120fps 33 < [

i | £ Scene 1
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5. Pindahkan masing-masing titik a, b, ¢ dan d, sesuai gambar. Titik akan berubah menjadi hijau.

6. Klik kembali mouse pada frame pertama. Dapat dilihat bahwa titik berubah menjadi kuning,

artinya, Shape Hint telah berhasil.

7. Jalankan animasi.
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KEGIATAN 5
MEMBUAT ANIMASI TEKS
BERUBAH-UBAH WARNANYA

TUJUAN

Setelah mengikuti kegiatan belajar ini, Anda diharapkan dapat:
e Menggunakan teks pada flash

e Mengkonvert teks menjadi vektor

e Membuat animasi teks berubah-ubah warnanya

URAIAN MATERI

A. Menggunakan Teks
Untuk menambahkan teks ke dalam stage pilih Text Tool ( T) pada foolbar kemudian klik pada
stage. Sebuah kotak kosong akan muncul. Untuk mengubah jenis, ukuran serta warna font,
gunakan jendela Properties di bagian bawah layar.

Pembuatan Animasi

Untuk mengatur
warna font

Untuk mengatur ukuran font
Untuk mengatur

: style font
Untuk mengatur jenis font

Untuk mengatur
perataan teks

| % Properties x | .Filters.l .Parametem.|

T ISTBticText v] A | calibri - |30 Hl-'l =
h‘,\" 1] El at [Normal v| |Anﬁ-alias for readability
W 289.4  x: 130.3 Lt [ Auto kern
. H:| 40.6 y: 179.7 o1 Untuk mengatur kehalusan teks Target:

B. Animasi Teks berubah-ubah Warna
Untuk sebuah judul program terkadang perlu dibuat menarik dengan cara membuat teks pada
judul tersebut bergerak atau berubah-ubah warnanya.

Dengan Adobe Flash CS3 Professional, membuat animasi tersebut bukanlah hal yang sulit.
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1. Pertama buat fi/e baru, melalui jendela Properties ubah warna background menjadi hitam.

B o000
||

[LLL]e

4

|3 Properties x | Filters | Parameters |

I
Fl Document Size: 550 x 400 pixels Background: - Frame rate: 12 fps
Untiled-9 Publish: Settings... Player: 9 ActionScript: 2.0 Profile: Default
Document dass: f

2. Pilih Text Tool (1)
3. Pada jendela Properties, atur : Static Text, Arial, 40 warna Kuning, Anti-alias for animation
(lihat gambar).

|c Properties x | Filters | Parameters |
Static Text ~| A Calibri * 40 EI J I %E = ca
.a.‘:.,' 0 E Al |Nnrmal v| |a5.nﬁ-alias for readability v|
W 126.0  y: 104.5 # | Auto kern
= H:| 52.9 y. 79.9 1] Target:

4. Klik mouse pada stage, ketikkan JUDUL (judul program).

5. Atur posisi agar di tengah layar kerja.
6. Pilih Modify > Break Apart atau tekan CTRL + B
Text Commands Control Debug

Document... Ctrl+)
Convert to Symbol... F&
| Break Apart Ctrl+B |

7. Pilih Modify - Convert to Symbol

Modify | Text Commands Central  Debug

Document... Ctrl+]

| Convert to Symbol... F&
Break Apart Ctrl+B
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8. Pada jendela Convert to Symbol, beri nama judul, pilih Graphic, pilih OK
[ Convert to Symbaol et ]

MName: | Judul oK
Type: () Movie dip Registration: Cancel

Button

@) Graphic S E—
; Advanced

9. Klik di frame 15 pada Timeline, Klik kanan mouse Insert Keyframe.

10.Klik di frame 30 pada Timeline, Klik kanan mouse Insert Keyframe.

11.Klik di frame 15 pada Timeline

12.Klik mouse pada teks JUDUL

13.Pada jendela Properties, pilih Color - Tint, atur warna ke Jingga (atau yang lain), kepekatan
100%.

B [srres00 Apha:[100% [« @)

“

|:. Properties % | Filters | Parameters ‘

Graphic w | Instance of: Judul Color: |T|nt .
mid ———
Swap... | [Loop ~|Frst: 1 RGB: 255 E| 102 E| 0 E|

oW 1118 x; 219.2 Blend: | MNormal

a
L H: 529 v 173.6 Use runtime bitmap caching

14.Blok frame 1 hingga 30, Klik kanan mouse pada timeline Pilih Create Motion Tween.

15.Jalankan animasi.
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KEGIATAN 6
MEMBUAT ANIMASI
DENGAN MASKING DAN PATH

TUJUAN
Setelah mengikuti kegiatan belajar ini, Anda diharapkan dapat:
¢ Membuat animasi dengan masking

e Membuat animasi mengikuti alur/guideline.

URAIAN MATERI
A. Animasi Masking
1. Buat sebuah file baru.
2. Ketikkan teks SMA BANI SALEH pada stage. Font. Calibri, Size: 48, Color. Biru. Atur agar
letaknya di tengah stage.

SMA BANI SALEH

] m

|:, Properties x | Filters | Parameters.|

g |Estisiot v| A calbri - w0 m IEE=E=ET5
A‘,\" 1] E| ad INormal v| IAntiﬁIias for readability '|
w: 2888y 1306 A3 |7] Auto kern
& Hi 528 |y 1736 @ Target:

3. Klik di frame 40 pada timeline, klik kanan mouse pilih Insert Frame.

4. Insert layer pada jendela Timeline, beri nama lingkaran.

| Latihan 4 |

s@a0: s 10 15 20 25 30 35 4t
b Lingkarar S0
Sl Layer 1 « « W,

Bl<:aod t TH B[ 40 120fps 335 4 I
5

Hinsert ayerJeene 1

35
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5. Buat sebuah lingkaran pada stage, ukuran lebih besar dari tinggi teks, warna bebas.

SMA B.SALEH

6. Klik mouse di frame 1 pada Timeline.
7. Pilih Modify - Convert to Symbol.
8. Beri nama lingkaran masking, pilih Graphic, pilih OK.

- .
Convert to Symbal &
Mame:  Lingkaran Masking OK,

Type: Maowie dip Reqistration: Cancel
I Button izl
@ Graphic T
Advanced
e

9. Dengan menggunakan Selection tool ( * ) atur gambar lingkaran kesamping kiri teks.

SMA BANI SALEH

10.Klik di frame 40 pada /ayer lingkaran, klik kanan mouse pilih Insert keyframe.

| Latihan 4* |
e s @01 5 10 15 20 25 30 35 @ 45 50 55 &0 65 70
.
U Layer 1 « o« @, | Create Motion Tween

Create Shape Tween

Insert Frame

Remove Frames
Rl 3@ & b @mH B [l 40 12.0fps 335« m

| Insert Keyframe |

LIT" % eSS Insert Blank Keyframe

11.Dengan menggunakan Selection tool ( * ) atur gambar lingkaran kesamping kanan teks.

SMA BANI SALEH

12.Blok dari frame 1 hingga 40 pada /ayer lingkaran, klik kanan mouse pilih Create Motion

Tween.

| Latihan 4+ |

sa: 5 10 15 20 25 30 35 45 50 59 60 65 70
Sl Layeri « + @), Create Motion Tween ||

Create Shape Tween

Insert Frame

Remove Frames
Bl “s@ @ t wmH B[] 40 120fps 338 ¢ T
Insert Keyframe
I;IJT. 'é Scene 1
Insert Blank Kevframe
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13.Pilih kotak kecil pada /ayerlingkaran, Klik kanan mouse pilih Mask.

| Latihan 4* |
g1 s 10 15 20 25 30 35
" Lingkaran # + +
3 Layer 1 . . E Show All
| Lock Others
Hide Others
Insert Layer
Bl @ @ Delete Layer 33 1 m.o
I;ﬂ % Scene 1 ; Giside
‘ Add Motion Guide
Mask
Show Masking

14.Jalankan animasi.

B. Animasi Gerak dengan Mengikuti alur (Guideline)
Untuk membuat animasi sebuah objek yang dapat bergerak mengikuti sebuah alur atau guide,
langkah-langkahnya sebagai berikut.
1. Buat File baru

2. Ubah nama layer 1 menjadi Bumi

| Latihan 5.2.fla* |
= a [
5 ;. o m
3. Buat sebuah lingkaran yang cukup besar di tengah-tengah stage. (Apabila mempunyai gambar

globe/bumi dapat digunakan dengan cara /mport)

| Latihan 5.2+ |
s a0 5 015 0 25 30 35 40 45 5 5 60 6

B“5E 3 t @mH %[ 1 120fps 0.0« | I

l;;m % Scene 1
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4. Klik kanan mouse pada lingkaran globe/bumi pilih Convert to Symbol, beri nama Bumi, pilih
Graphic, klik OK. (Apabila objek globe/bumi berasal dari gambar yang Anda Import

sebelumnya, Anda dapat lewati dan abaikan langkah ini)

Convert to Symbol @

Mame:  Bumi QK
Type: () Movie dip Registration:

() Button

(@) Graphic
|

Tambahkan /ayer baru pada Timeline, dengan cara mengklik mouse pada ikon Insert layer

5.
beri nama Bulan.
| Latihan 5.2* |
= a0
u s+ s+ W
al Bumi « « [
6. Buat lingkaran yang lebih kecil dari lingkaran bumi. (Apabila mempunyai gambar bulan dapat
digunakan dengan cara Import)
7. Klik kanan mouse pada lingkaran bulan pilih Convert to Symbol, beri nama Bulan, pilih

Graphic, klik OK. (Apabila objek bulan berasal dari gambar yang Anda Import sebelumnya,

Anda dapat lewati dan abaikan langkah ini)

Convert to Symbol @

Mame: Bulan QK
Type: () Movie dip Reqgistration:

() Button




8. Pilih ikon Add Motion Guide pada jendela Timeline

| Latihan 5.2* | | Latihan 5.2* |
: sal|] s : sa0|] s
&l Bumi + « M| .
‘ Al Bumi + « @
s ita  @nas it
] B - s

9. Buat sebuah lingkaran kosong (tanpa Fill) dan atur posisinya seperti di bawah ini.

10.Dengan bantuan Eraser Tool (<) hapus sebagian lingkaran tadi hingga terputus.

11.Klik kanan mouse di frame 60 pilih Insert Keyframe (untuk ketiga /ayer)

| Latihan 5.2% |

i =8 0 5 10 15 20 25 30 33 40 45 50 53 65 70 75 80 85 a0
. TsGuide:Bubn  + + H
a Bulan « o [

Create Motion Tween

Create Shape Tween

Insert Frame

g ——— Remove F <
EURLIS: | |} % % [ 1 12.0fps 00s < i S AT

Ii"l: | % Scene 1 . I Insert Keyframe

e
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12.Pilih frame 1 pada /ayer Bulan, dengan menggunakan Selection tool ( } ) atur lingkaran bulan

hingga titik tengahnya pada posisi awal lingkaran guideline bulan.

| tatihan 5.2+ |
H = a1 3 10 15 20 25 30 35 40 45 50 33 [
"% Guide: Bulan « o+ H, i
@l Bufan « o O, i
= Bumi £ o HH i
&l 3@ 8 b @mf B[] 60 12.0fps 49 < 0
t 5 Scena 1

13.Pilih frame 60 pada /ayer Bulan, dengan menggunakan Selection tool (* ) atur lingkaran
bulan hingga titik tengahnya pada posisi akhir lingkaran guideline bulan.

| Latinan 5.2 |
i sald: s 10 15 20 25 30 35 4 45 50 55 5
<% Guide: Bulan + + H, D| |
= Bufan o L. 0
%l Bumi « « @ il
&l Ss@ § ¢ T & [ 60 120fps 49« 1
LIZE % Scene 1

14.Blok frame 1 hingga 60 pada /ayer bulan, klik kanan mouse pilih Create Motion Tween.
| Latihan 5.2+ |

"5 Guide: Bulan
= Bulkn v
R Bumi Create Motion Tween

Create Shape Tween

Insert Frame

Rl 3@ & 8 Remove Frames
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15.Jalankan animasi.

16.Untuk menghilangkan garis guideline, klik ikon mata pada /ayer Guideline bulan.

| Latihan 5.2 |

L L
s Guide: Bulan . .E- :
Sl Bumi R DI- -
——— [t @ = [ 60 120fs 495 < [m_]

17.Jalankan animasi.
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KEGIATAN 7
MEMBERI SUARA PADA ANIMASI

TUJUAN
Setelah mengikuti kegiatan belajar ini, Anda diharapkan dapat:
e Mengimpor suara

¢ Memasukan suara pada animasi.

URAIAN MATERI
A. Mengimpor Suara
1. Buka file animasi masking/Latihan 4. (ini hanya untuk mempercepat tutorial)
2. Pilih File > Import > Import to Library
3. Pilih file suara yang akan digunakan (pada tutorial ini kita akan menggunakan file suara yang
terdapat di direktori C:\Windows\Media\Windows Logon Sound)

B. Memasukan Suara pada Animasi

1. Buat /ayerbaru pada Timeline, beri nama suara.

| Latihans* |

= 8@ D 1 5 10 15 20 25 30 35
BTN

B Linakaran - @ |,
B Layer1 « @ m,

B 5@ S b mH B[] 40 120fps 338« 1.

2. Klik mouse di frame 1 pada /ayer suara.

3. Pilih jendela Properties, pada kolom suara pilih Windows Logon Sound
. [ = Properties x | Filters | Parameters |

l! Frame Tween: Sound: [None v]

Mone
Frame Label > Effect: s pmm—rmm—

Label type: Sync: [Event - J [Repeat vJ 1

Mame Mo sound selected

4. Jalankan animasi
Catatan:

Apabila suara yang digunakan waktunya lebih pendek dari pada animasinya, Anda dapat mengubah

kolom Repeat ke Loop atau mengubah nilai Repeat lebih besar dari 1.
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KEGIATAN 8
MEMBUAT TOMBOL KONTROL (PLAY DAN STOP)
UNTUK ANIMASI

TUJUAN
Setelah mengikuti kegiatan belajar ini, Anda diharapkan dapat:
e Membuat tombol

e Memberi action pada tombol.

URAIAN MATERI
A. Membuat Tombol
1. Buka file animasi masking/Latihan 4. (ini hanya untuk mempercepat tutorial)
2. Buat /ayer baru, beri nama Kontrol sehingga menghasilkan keadaan seperti yang ditunjukkan

pada gambar di bawah.

| Latihan 7* |
= @ [ 5 10 15 20 25 30 35
|7 kontol o+ - = 8
%l Suara « + [Oig
B Lingkaran - @ W, |
B Layer1 - @ O, TJ
Bl @ @ { T B[] 40 12.0fps 33 4 [ .

3. Pilih menu Window -> Common Libraries > Buttons S -
. . . | Library - Buttons x |
4, Pada jendela Library - Buttons, pilih Playback 277 tems

rounded - rounded green play. Klik mouse dan geser
gambar tombol yang muncul di stage. Atur letaknya pada »
bagian bawah stage.

Mame

[¥ playback rounded a
éﬁ rounded green back
[%i| rounded green center playl 3
ﬂﬁ rounded green forward
ﬂ% rounded green pause E
ﬁ% rounded green play |

ﬂ% rounded green stop

|| O S T T 18
< [ P

III *

5. Pada jendela Library — Buttons, pilih Playback rounded > rounded green stop.
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6. Klik mouse dan geser gambar tombol yang muncul ke layar. Atur letaknya di samping tombol

play.

B. Memberi perintah action pada tombol.
B.1. Memberi perintah action play pada tombol play
1. Klik gambar tombol p/ay pada stage.

2. Pilih jendela Actions yang terdapat di bawah layar, atau pilih window > Actions.

gl

- Global Functions > Movie Clip Control > on

a3

3. Pada jendela Actions pilih ikon

] Actions - Button x [ =

| [Actionsript 1.0 & 2.0 -] POvE|IER[HEY OEI|E N saptasst @

E Global Functions - Global Functions 4 Movie Clip Control 4 duplicateMavieClip Esc+dm
Movie Clip Control = ActionScript 2.0 Classes r Timeline Control r etPrope
: : P g P!
Timeline Contrs i =
E‘ A Global Properties 3 Browser/Netweork 3 on Esc+on
@ gotoAndrlay i
@ gotoAndstop Operators 3 Printing Functions 3 onClipEvent Esc+oc
@ nextFrame Statements 3 Miscellaneous Functions 3 removeMovieClip Esc+rm
@ nextscene Cornpiler Directives 4 Mathematical Functions 4 setPropel Esc+s
P P p
.
@ pIalel Constants 3 Conversion Functions 3 startDrag Esc+dr
=] Current Selection - Types L4 stopDrag Esc+sd
r_% rounded green play Deprecated ¥ targetPath
é Scene 1 Data Components 3 updateAfterEvent
¢| Symbol Definition(s) Components B .
Screens 3
i Line 1 of 1, Col 1

4. Pilih release pada menu pilihan yang muncul.

| Actions - Button x |

| ActionScript 1.0 &2.0 || R PO EERE ITETC
@ Global Functions - P on ) {
Movie Clip Control |E| 2 N @ press -
[E] Timeline Control B 3 (@ release : ||:|
@ gotoandPlay % :E:E\?:FUtS'de
@ gotoAndStop @ rolout
@ nextFrame @ dragOver
@ nextScens | @ dragOut
@ D|a!-lf i il @ keyPress "<Left=" -




47

5. Klik mouse di tengah tanda kurung kurawal pada jendela actions.

| Actions - Button x |

[ActionScript 1.0&2.0 ]| &P OwERELITE ¥
@ Global Functions - 1 sl
Mavie Clip Contral |E| 2 N @ press B
[E] Timeline Contral b 3 (@) release . 3
@ gotoAndrlay @ re:leoaseOutmde
@ o 8o
@ nextFrame @ dragover
@ nextScene @ dragout
@ play 'H @ keyPress "<lLeft>" -

6. Double klik pada pilihan play
7. Sehingga script pada jendela Actions tampak seperti di bawah ini.

| Actions - Button x |
.lAction5cri|:lt1.0&2.0 - | R POGVYE L ITH YL

on (release) { plavi():

Mowie Clip Control

EJ Timeline Control
@ gotoAndPlay
@ gotoAndStop
@ nextFrame
@ nextScene

lam,| »

[F- N TR S I S

@ prevFrame ¥ H
r - 1

Catatan.: Bila Anda sudah terbiasa dan hapal dengan Anction Script pada Adobe Flash CS3
Professional, Anda tidak perlu lagi melakukan langkah ke 3 s/d 7 di atas. Anda bias langsung

mengetikkan script-script yang Anda perlukan secara manual pada form Action.

B.2. Memberi perintah action stop pada tombol stop
1. Klik gambar tombol stop pada stage.
2. Pilih jendela Actions yang terdapat di bawah layar, atau pilih window > Actions.

gl

| Actions - Button x | o-=

3. Pada jendela Actions pilih ikon - Global Functions > Movie Clip Control - on

[ Actionseript 1.0 & 2.0 -] POwE|ERE|IIEYOME [B ™\ Script Assist @
E Global Functions - Global Functions 3 Movie Clip Control 3 duplicateMaovieClip Esc+dm
Movie Clip Control |E | ActionScript 2.0 Classes 3 Timeline Control 3 getProperty
Timeline Control i
@ Attt Global Properties 4 Browser/Network 4 on Esc+on
@ gotoAndrlay - . "
@ gotoAndstop Operators 4 Printing Functions 4 onClipEvent Esc+oc
@ nextFrame Statements 4 Miscellaneous Functions 4 removeMovieClip Esc+rm
@ nextScene H Compiler Directives 3 Mathematical Functions 3 setProperty Esc+sp
Jpl_a% Constants 3 Conversion Functions 3 startDrag Esc+dr
= Current Selection - Types > stopDrag Esc+sd
r&__% rounded green play Deprecated 4 targetPath
% Seene 1 Data Components 4 updatelifterEvent
Symbal Definition{s)
@ Components 3 T
Screens 3
T | |Unelof1, Coll




. Pilih release pada menu pilihan yang muncul.

Ij Actions - Button X |

| ActionScript 1.0 &:2.0 -] | &P D EEL ST
@ Global Functions - on ) {
(7] Movie Clip Control El H @ press ~
[E] Timeline Contral @ release 3
@ gotoAndrlay @ releaseOutside
@ gotoAndstop @ rolover
@ nextFrame % [:lc:![g}u[}?\rer
@ nextScene EI @ dragout
@ Dla!rl' __ il @ keyPress "<Left=" -

. Klik mouse di tengah tanda kurung kurawal pada jendela actions.

Ij Actions - Button X |

| ActionScript 1.0 &:2.0 -] | &P D EEL ST
@ Global Functions - on ) {
(7] Movie Clip Control El H @ press ~
[E] Timeline Contral @ release 3
@ gotoAndrlay @ releaseOutside
@ gotoAndstop @ rolover
@ rollout
@ nextFrame @ dragover
@ nextScene EI @ dragout
@ Dla!rl' __ il @ keyPress "<Left=" -

. Double klik pada pilihan Stop

7. Sehingga script pada jendela Actions tampak seperti di bawah ini.

Ijm]
|Actionscript 1.0 &2.0 || R PG EEETTE Y
@ nextFrame on (release) { =stop():

@ nextScene
@ play
@ prevFrame
@ prevScene
@ stop |

@ stopalSounds
m] Browser Network 5 E|
r - 1

»

}

o

. Buat /ayerbaru pada Timeline beri nama Script.

| Latihan7* |
i FRAO1 5 10 15 20 25 30 35 E]
= Script # +« +« AN
Sl Kontrol -+« W,
Sl Suara « o+ [
_ Bingkazn  + @ W, |
B Layer1 + @ o, HU
Rl <= & (¢ TH % [ 40 120fps 335 4 m

8. Klik kanan mouse di frame 1, /ayer Script, pilih Insert Blank Keyframe.

9. Klik mouse di frame 1, layer Script.
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10.Pada jendela Action ketikkan stop();

| Actions - Frame x |

' [Actionscript 1.0 82,0 R P OYE L ITETC

@ Global Functions - 1  =topl):
(7] Movie Clip Control |E |
[E] Timeline Contral TN

@ agotoAndPlay

@ gotoAndStop

@ nextFrame

@ nextScene

@ play = H
r " 1

11.Klik mouse di frame 1, layer suara, dengan cara klik dan geser pindahkan titik (keyframe)

1 ke frame 2.
| Latihan 7* |
i = a O ﬂ 5 10 15 20 25 30 35 40
%l Script - I:I'E| 0
wl Kontrol « + Wl i
RN ,
B Lingkaran - @ N, 5
B Layer1 « @ o, g

Rl @ @ ¢ i §a [ 2 12.0fps Ods 4| T
12.Jalankan animasi dengan cara, Pilih Control > Test Movie atau tekan tombol ctrl +
Enter

13.Coba tekan tombol play dan stop bergantian.
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KEGIATAN 9
MEMBUAT ANIMASI SIKLUS HIDUP KUPU-KUPU

TUJUAN
Setelah mengikuti kegiatan belajar ini, Anda diharapkan dapat membuat animasi siklus hidup kupu-

kupu dengan memanfaatkan tool pada Adobe Flash CS 3 Professional.

URAIAN MATERI
A. Menyiapkan File Baru
1. Buat File baru dengan setting properties sebagai berikut.

-

-
Document Properties

Title:

Description: "
Dimensions: | 400 pl (width) x 400 px (height)
Match: () Printer Contents (@) Default

Background color: ol

Frame rate: 12 fps
Ruler it
Make Default [ QK l ’ Cancel ]

e

2. Kemudian buat empat layer pada Timeline masing-masing dengan nama, kupu-kupu, telur,

ulat dan kepompong.

| Untitled-1* |

i = @ [ 5 10 15 20 25 30 35 40
al Kepompong « « @
Al Lt « +« []
al Telur + « H

Bl <@ @ } @ %[ 1 120fps 00s <« [m__
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B. Membuat Gambar

1.

Pada frame 1 layer kupu-kupu beri gambar kupu-kupu (Anda dapat

mengimpor atau membuat gambar sendiri).

Pada frame 1 layer telur beri gambar telur.

Pada frame 1 layer ulat beri gambar ulat.

Serta pada frame 1 layer kepompong beri gambar kepompong.

Kemudian atur agar posisi gambar sebagai berikut.

LD

Telur

Ulat

Kupu-Kupu

Kepompong

e

Kupu-Kupu

D

Telur

AT

Ulat

b

Kepompong

Buat layer baru di antara layer kupu-kupu dan layer telur, beri nama Panah

1. Pada frame 1 nya beri gambar panah seperti berikut.

Pada frame 1 nya beri gambar panah seperti berikut.

Buat layer baru lagi di antara layer ulat dan layer kepompong, beri nama

Panah 3. Pada frame 1 nya beri gambar panah seperti berikut.

Buat layer baru lagi di atas layer kepompong, beri nama Panah 4. Pada

Buat layer baru lagi di antara layer telur dan layer ulat, beri nama Panah 2. \

frame 1 nya beri gambar panah seperti berikut.
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10. Kemudian atur agar semua gambar posisisnya sebagai berikut.

oD
/ Telur
o0 -~

Kupu-Kupu /

Kepompong

11. Pastikan posisi urutan layer seperti pada gambar.

| Latihan &* |

; = @ Dﬁ 5 10 15 20 25 30 35 40
™ Ppanah 4 - 4
al Kepompong . . l._
l Panah 3 . . .:
Al Ut + + Oy
9l Pansh 2 . . .:
a Telur . . ..__
9 Panah 1 + + Hliy
qJ__ Kupu-Kupu . . I:l.__
Bl %@ 8§ { m'H W[ 1 120fis 00s <4 m |
Catatan.

Bila objek kupu-kupu, telur, ulat dan kepompong yang ada di stage seperti yang sudah dijelaskan
pada langkah-langkah di atas dimana objek-objek tersebut tidak Anda buat sendiri melainkan
berasal dari sebuah file yang Anda import, ada baiknya sebelum kita melangkah lebih jauh, Anda
ubah objek Anda yang berbasis bitmap menjadi objek berbasis vector dengan cara memilih objek
yang akan diubah, klik menu Modify - Bitmap > Trace Bitmap, dan masukkan nilai seperti
yang sudah dipelajari pada bab kegiatan 3 pada modul ini. Kemudian convert masing-masing objek

tersebut menjadi symbol dan beri nama sesuai dengan bentuk objeknya.
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C. Mengatur Gerakan Animasi
1. Geser frame 1 pada layer kupu-kupu ke frame 5.

2. Klik kanan mouse di frame 9 pada layer kupu-kupu, pilih insert keyframe.

[ Untitled-1+ |
@01 s |:|1n 15 20 25 30 35 40
al panzh 4 - - B,
wl Kepompong + + W,
wl panzh 3 + + @O,
Wl Ut + + Oyl
Wl Panzh 2 + + B,
Al Telur = - W,
%l Panah 1 « « @i,
L kupukupu -+ = [ERVERRI
Rl %0 & b mH %[ 9 120fps 07 4 [m

3. Klik frame 5 pada layer Kupu-Kupu. Pada jendela properties pilih color pada posisi Alpha

dengan intensitas 0%, seperti yang ditunjukkan pada gambar.

]e Properties x | Filtersl Parametﬁs_l

] —— - B
[Swap... ] [Loop = |First: 1

— w: 1104 x: 15.5 Blend: | Mormal

]

L H: 756 ye 162,2 Use runtime bitmap caching

4. Blok frame 5 sampai dengan frame 9 pada layer Kupu-Kupu, klik kanan mouse kemudian pilih
Create Motion Tween.

5. Geser frame 1 pada layer Panah 1 ke frame 10, dan pada frame 20 lakukan insert
keyframe.

6. Kemudian buat layer baru di atas layer Panah 1, beri nama Penutup 1.

Pada frame 10 insert blank keyframe.

| Untitled-1* |
i @@ [ 5 Iﬂ] 15 20 25 30 35 40
4l Panah 4 « + A,
4l Kepompong + + B
al Panah 3 + + W
A Ukt « « O
al Panah 2 + +
al Telur « « A,
=M Penutup 1 # + + HA I:IE O
al Panah 1 + « W Ojs D|-
l Kupu-Kupu + o« W, e
Bl <3 @ } m %[l 10 120fps 08 <[ m |
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Klik mouse pada frame 10 layer Penutup 1, dengan menggunakan rectangle tool (=.), buat

sebuah kotak di stage dengan ukuran menutupi gambar Panah 1. Warna terserah Anda.

| Untitled-1* |

| Y Al Panzh 4
'S = Sl Kepompong
= al Panzh 3

& T Ukt
~ @ al Panah 2
= =
s Telur
[ie] & Sl Panah 1

Ql Kupu-Kupu
Al “3@ §

i E scene 1

4 .

Klik mouse dua kali pada gambar kotak, kemudian pilih Modify - Convert to symbol. Pada

jendela dialog yang muncul, masukkan nilai seperti pada gambar berikut ini. Lalu klik tombol

OK.

-

Convert to Symbaol

Mame:  Penutup] K
Type: () Movie dip Registration: _ﬁ: Cancel
I () Button o

| @ Graphic
Advanced

[l

L

10. Klik frame 20 pada layer Penutup 1, klik kanan mouse lalu pilih Insert Keyframe
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11. Klik frame 10 pada layer Penutup 1, pilih Selection Tool ( } ) lalu geser objek Penutup 1

seperti yang ditunjukkan pada gambar berikut ini.

| Untitled-1* |

25 30 35 40 43 50 35 6

Panzh 4
Keumnuung_
Panzh 3
Ukt

Panzh 2
Telur

A& 44| &| A

Al Panzh 1
al Kupu-Kupu
Bl 5o d t BH B[] 10 120fps 08 4 i |

i E scene 1

12. Blok frame 10 sampai dengan frame 20 pada layer Penutup 1, klik kanan mouse lalu pilih
Create Motion Tween.
13. Klik kanan mouse pada kotak kecil di layer Penutup 1, pilih Mask.

| Untitled1= |

%l Panah 4
W Kepompong
9 Panah 3
[l Uit
a Panah 2
d Telur
= o
AL Show All
Al Panah 1 + Lock Oth
Sl Kupu-Kupu « o 2 e
Ri#: G F - Hide Others
l;k | % Scene 1 Insert Layer
Delete Layer
Guide
Add Motion Guide
Mask
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Maka posisi pada layer akan berubah seperti berikut.

[ Untitled-1+ |
i 2ag0: s 10 15 H} 25 30 35 40
al Panah 4 + « H
Sl Kepompaong . .
%l Panah 3 - « @
Rl Ukt -« [
%l Panah 2 - « H
al Telur -« W
“ Penutup 1 4 [ ]
& panah 1 « @ ol Ole 0
Al Kupu-Kupu « «» W, g ..
Bl“5@ 9 f W W [] 20 120fps 16s 4 [Loom ]

Apabila animasi dijalankan, maka Panah 1 akan muncul secara perlahan.
Setelah animasi Panah 1 berhasil, selanjutnya menganimasikan munculnya gambar telur

secara dissolve.

Geser frame 1 pada layer Telur ke frame 21.

Klik kanan mouse di frame 25 pada layer Telur, pilih insert keyframe.

| Untitled-1* |
wAag0O1 s 10 15 20 ﬁ 30 35 40
4l Panah 4 + +« @
%l Kepompong ..
4l Panah 3 « + O
A Ukt + - 0O
4l Panah 2 + + @
= Telur A - - B, Oe 0O
B penutup 1 « a0 O
B panah 1 « ad Ole Il
al Kupu-Kupu + ¢+ Hs perse
AEETER- f T R[] 25 120fps 205 o4 [l

Klik frame 21 pada layer Telur. Pada jendela properties pilih color pada posisi Alpha

dengan intensitas 0%, seperti yang ditunjukkan pada gambar.

| & Properties x I Filters | Parameters [
Instance of: Telur Color: 0% EI
[Swap... ] ’Lcop * |First: 1
- w: 67.1 W 1728 Blend: | Mormal
a._ H: 45.5 v 30,4 Use runtime bitmap caching

Blok frame 21 sampai dengan frame 25 pada layer Telur, klik kanan mouse kemudian pilih
Create Motion Tween.

Geser frame 1 pada layer Panah 2 ke frame 26, dan pada frame 35 lakukan insert
keyframe.

Kemudian buat layer baru di atas layer Panah 2, beri nama Penutup 2.
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20. Pada frame 26 insert blank keyframe.

| Untitled-1* |
@01 s 10 15 20 2ﬂ a0 35 40
Al Panzh 4 + « W,
al Kepompong + +« @,
wl Panah 3 « « W,
Al Ulat « o« O}
7 penutwp2 . - mf ol 0
al Panah 2 -« [l Olé Ole
al Telur + - A Ojw:—s
B Penutup 1 « @ O e
B Panzh 1 « @ O Ole |:||.
2l Kupu-Kupu « « W, e 4
[ W b @y B[ 2 120fps 218 o« [om

21. Klik frame 26 pada layer Panutup 2. Pada panel Library, cari objek dengan nama Penutup,
klik lalu drag/geser kearah stage. Tempatkan objek kotak tersebut di atas objek Panah 2,
sehingga objek panah 2 tertutup seluruhnya oleh objek Penutup yang ada pada layer

Penutup 2.
| Untitied 1+ | - e
; sald: s 15 20 25 3 E} @ 45 0w s e ss 75 s a5 o c.zfffl Colorx | Swatches| =
9 Panah 4 . m| N IEd - Typei[sokd  ~]
% Kepompong + Hiy| &
W Panah 3 + Ol "
Q2 Uit . . 0l
|~ eeviip2 . . = E BT
W Panzh 2 . [=]8 G 0 El I‘
Sl Telur =18 n.>_..‘ B: 0 El
B Penutup 1 - a0, B Alpha:  100% E| #FFO000
B panah 1 a . I s i
 Kupu-Kupu ¢ s @y gasrsl -
=N t BT % [] 35 120fps 28 o« [m_] » _
o 5 Scene 1 Workspace £ 41, 92% -
[ Libraryx | 7_;
& @
9 items
Name Type &
Kepompong Graph 8
Kupu-Kupu Graph:
Panah 1 Gmph“l
[ Panah 2 Graph
[%) Panah 3 Graph
[ panah 4 Graph
i penutp . Greph
Telur Graph
Ulat Graph

22. Klik frame 35 pada layer Penutup 2, klik kanan mouse lalu pilih Insert Keyframe
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23. Klik frame 26 pada layer Penutup 2, pilih Selection Tool (%) lalu geser objek Penutup 2

seperti yang ditunjukkan pada gambar berikut ini.

| Untitled-1* |

D D s e L L T T

Sl Panah 4 . H,

@l Kepompong + @,

S Panah 3 - @,

Ql Uit + O]

= Ppenutup 2 v . N I O

S Panah 2 - B, i il

&l Telur + B, Ole — o
_Brpenutip1 - @ O -

B Panah 1 aod| e EIJ;|

Sl Kupu-Kupu » B, gh:
EReEY ] Pt W0 2% 206 2 [m
Lﬁ| %Scenel

Blok frame 26 sampai dengan frame 35 pada layer Penutup 2, klik kanan mouse lalu pilih

24.
Create Motion Tween.
25. Klik kanan mouse pada kotak kecil di layer Penutup 2, pilih Mask.
| Untitied-1* |
i 2 O [T — 10l S
S Panah 4 - - N il il
S Kepompaong + + @
a Ppanah 3 + + [0
Al Ut « o O
™ penutup 2 P
S Panah 2 + + B el
o Telur . o 1 Lock Others
_Wpenutup1 - & 0 FedeOies
E? Panah 1 + @l el
:1.|v‘-'] K_LIDL;KUDU + - O Delete Layer
£ B
R | B Scene 1 Ellice

Add Motion Guide

Mask
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Maka posisi pada layer akan berubah seperti berikut.

| untitled-1+ |
i s @1 s 10 15 20 25 0 H; 40
%l Panah 4 R |
Wl Kepompaong « « @
al Panah 3 « « O
Sl Ukt « « [0
@ Penutup 2 ¥ ]
B panah 2 - @ |, Ole 0
al Telur « +» W, Oes s [E
B Penutup 1 « @ O, e
B panah 1 - @ O, Ole |:||.
al Kupu-Kupu o+« W, gesse
Rl <5 @ @ { @t W [ 35 120fps 28 4w

Apabila animasi dijalankan, maka Panah 2 akan muncul secara perlahan.
Setelah animasi Panah 2 berhasil, selanjutnya menganimasikan munculnya gambar telur

secara dissolve.

Geser frame 1 pada layer Ulat ke frame 36.
Klik kanan mouse di frame 40 pada layer Ulat, pilih insert keyframe.

| Untitled-1* |
“ sali1 s 10 15 20 25 30 35 H} 45
Wl Panah 4 + + A,
9 Kepompong « « H
< Panah 3 + + O
et s - - mf de 0o
B Penutup 2 - @ O 1] R —
B panah 2 - @ B, Ole Ol
< Telur + + B O
B Penutup 1 - a O e g
B panzh 1 « @ O Oje III|-
Sl Kupu-Kupu « « B, g
Bl 3@ m f B % [ 40 120fps 338 < T

Klik frame 36 pada layer Ulat. Pada jendela properties pilih color pada posisi Alpha dengan

intensitas 0%, seperti yang ditunjukkan pada gambar.

|.z Properties x I Filters | Parameters [
Instance of: Ulat Color: 0% El
’@ [Swap... ] [Loop - |First: 1
— W: 83.0 ¥: 3010 Blend: | Mormal
a._ H: 24.2 v 189.0 Use runtime bitmap caching

Blok frame 36 sampai dengan frame 40 pada layer Ulat, klik kanan mouse kemudian pilih
Create Motion Tween.

Geser frame 1 pada layer Panah 3 ke frame 41, dan pada frame 50 lakukan insert
keyframe.

Kemudian buat layer baru di atas layer Panah 3, beri nama Penutup 3.
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32. Pada frame 41 insert blank keyframe.

| untitled-1+ |
i sali s 0 15 20 25 30 35 *ﬂ 45 s
Al Panah 4 . e Ig{
4l Kepompong « « [},
" Penutup 3 FA o il 0
4l panah 3 « « M|, 0 Ol
al Ut + « O Do
B renutup 2 - @ Oj Oe: - 5a
B ranah 2 @ |, Ole Ols
S Telur -« E, Ols s—s &
B Penutup 1 - @ O, Ol g
B Panah 1 « @ dpg Ole e
 Kupu-Kupu o+« B, pgas.a
Rl <5 @ 3 {f W B [ 41 120fps 338 4 [ m

33. Klik frame 41 pada layer Penutup 3. Pada panel Library, cari objek dengan nama Penutup,
klik lalu drag/geser kearah stage. Tempatkan objek kotak tersebut di atas objek Panah 3,
sehingga objek panah 3 tertutup seluruhnya oleh objek Penutup yang ada pada layer

Untitled1* fa_________"]
[ Untitied-1* | Gl e
: sabd: s 0 15 20 25 3 35 4 45 s 55 0 5 7 s s 85 oo e.zffl Colorx | Swatches | -=
9 panah 4 - W) N IEd TYDEI
W Kepompong . s -l | =S 1
™ Penutup 3 e .
] 3 i .
S panan 3 < s ] o ]
W Ukt - O e Re 25 [
B Penutup 2 a0, 0 o =l G 0 B I‘
B panah 2 - am Dl- B: 0 B
9 Telur 18 i Apha: 100% ]  #FFO000
& Penutup 1 - a0 e g
Panah 1 . O, Ols D‘- L
e e = _
Ao R b BE % [ 41 12.0fps 335 4 | 1, »
o £ Scene 1 Workspacev £ 4l 87% - —
| Libraryx | p=
Py
9 ftems

Name

@ Kepompong
(=) Kupu-Kupu
[ panah 1
[#) panah 2

34. Klik frame 50 pada layer Penutup 3, klik kanan mouse lalu pilih Insert Keyframe
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35. Klik frame 41 pada layer Penutup 3, pilih Selection Tool ( * ) lalu geser objek Penutup 3

seperti yang ditunjukkan pada gambar berikut ini.

| untitled-1* |

] Telur

_qJ Panzh 4
al Kepompaong

W Pariah 3
U ult

B Penutup 2
Panah 2

 Bpenutup1
© panah 1
Al Kupu-Kupu

I;I."E : % Scene 1

¢ mh B[] 41 120fps 33 <[ m ]

36. Blok frame 41 sampai dengan frame 50 pada layer Penutup 3, klik kanan mouse lalu pilih

Create Motion Tween.

37. Klik kanan mouse pada kotak kecil di layer Penutup 3, pilih Mask.

| untitled-1* |

Al Panah 4
@l Kepompong
™ Penutup 3
Al panzh 3
_ W vkt
E Penutup 2
B panah 2
] Sl Telur
B Penutup 1
B panah 1
W Kupu-Kupu
T
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R

-
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Show All
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Insert Layer
Delete Layer

Guide
Add Motion Guide
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Maka posisi pada layer akan berubah seperti berikut.

| untitied-1* |
s@ad: s 10 15 20 25 30 35 +[| 45 50 ]
Sl Panah 4 LI .!{
al Kepompong + o+ Wi
& panah 3 « a O 0 Ole
al Ukt « « [, Ole >— »
B Penutup 2 « @ O e
B panah 2 - @ H Ole |;||.
al Tealur + « W, oe: &
B Penutup 1 - @& O e
B Panah 1 « @ @, Oe |;||.
Al Kupu-Kupu o +« B, p ..
Bl 3@ t mH W O[] # 120fis 33 4 m

Apabila animasi dijalankan, maka Panah 3 akan muncul secara perlahan.
Setelah animasi Panah 3 berhasil, selanjutnya menganimasikan munculnya gambar Ulat

secara dissolve.

Geser frame 1 pada layer Kepompong ke frame 51.
Klik kanan mouse di frame 55 pada layer Kepompong, pilih insert keyframe.

| Untitled-1~ |
E sald: s 10 15 20 25 30 3/ 40 45 50
W Panah 4 R 1
" Kepompong  # + « I § Oe O
B renutup 3 - @ | e » .
B panah 3 « @ @, Ole Ole
9 Ukt .« O ke
B Penutup 2 « @ O e 4
B panah 2 « @ |, Ols |:||.
Al Telur + « B, Oes s
B Penutup 1 - a0 e
B Panah 1 - @0 Ols IIIJ3|
%l Kupu-Kupu o« Wi, pessa
Bl 0@ t ®H % [ 55 120fps 45 4 T

Klik frame 51 pada layer Kepompong. Pada jendela properties pilih color pada posisi Alpha

dengan intensitas 0%, seperti yang ditunjukkan pada gambar.

| & Properties x | Filters | Parameters |

Instance of: Kepompong 0% EI
mh
[Swap... I [Loop = |First: 1
— w: 8L1 x: 159.4 Blend: | Mormal
8
L He| 66.7 e 308.1 Use runtime bitmap caching

Blok frame 51 sampai dengan frame 55 pada layer Kepompong, klik kanan mouse kemudian
pilih Create Motion Tween.

Geser frame 1 pada layer Panah 4 ke frame 56, dan pada frame 65 lakukan insert
keyframe.

Kemudian buat layer baru di atas layer Panah 4, beri nama Penutup 4.
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Pada frame 56 insert blank keyframe.

| Untitled-1* |
i sald: s 10 15 20 25 30 35 40 45 50 5 60 85 ;
< penutup 4 s+ R O III|
A Panzh 4 + « H i Ol
Ql Kepompaong « +« B,
B Penutup 3 - 8 |,
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Rl Telur « « W,
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B panah 1 « a O
al Kupu-Kupu « o« @
B 3@ & 4

Klik frame 56 pada layer Penutup 4. Pada panel Library, cari objek dengan nama Penutup,
klik lalu drag/geser kearah stage. Tempatkan objek kotak tersebut di atas objek Panah 4,
sehingga objek panah 4 tertutup seluruhnya oleh objek Penutup yang ada pada layer
Penutup 4.

| untitied1* | -8x e v
ea0d: 5 © 15 = 25 3 3 4 4 s Bl e e ™ 7 s a5 s c-=fj Colorx | Swaiches | =
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46. Klik frame 65 pada layer Penutup 4, klik kanan mouse lalu pilih Insert Keyframe
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47. Klik frame 56 pada layer Penutup 4, pilih Selection Tool ( } ) lalu geser objek Penutup 4
seperti yang ditunjukkan pada gambar berikut ini.

Untitled-1% |
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48. Blok frame 56 sampai dengan frame 65 pada layer Penutup 4, klik kanan mouse lalu pilih

Create Motion Tween.
49. Klik kanan mouse pada kotak kecil di layer Penutup 4, pilih Mask.

| Untitled-1* |

T T — Ul e P
" Penutup 4 P
9l Panah 4 o o | sl
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Maka posisi pada layer akan berubah seperti berikut.

[ Untitied-1* |

<+ Penutup 4

& Panah 4 a
Ql Kepompong . .
B Penutup 3 - @

EP panah 3 « @
Al Ukt . .
B Penutup 2 - a8

& Panah 2 « @
Rl Telur . .
B Penutup 1 - @

B panah 1 « @
2l Kupu-Kupu L

Al 5o F

Apabila animasi dijalankan, maka Panah 4 akan muncul secara perlahan.

Setelah animasi Panah 4 berhasil,

o [0

o [0

o [0

o [0

OoO0mEODCOOE DR

Kepompong secara dissolve.

selanjutnya menganimasikan
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munculnya gambar

Selanjutnya, Klik mouse di frame 70 pada layer kupu-kupu, tekan tombol shift, tahan, klik

mouse frame 70 pada layer Penutup 4. Klik kanan mouse pilih Insert Frame.

o

Al 30 F 4

Ole — of

' % [l 65 120

fps 5.3 4

.

| Untitled-1+ |
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Create Motion Tween

Create Shape Tween

Insert Frame

Remove Frames

Insert Keyframe

Insert Blank Keyframe

Clear Keyframe

Convert to Keyframes
Convert to Blank Keyframes

Cut Frames




Maka pada layar monitor akan menjadi seperti gambar berikut.

| untitled-1= |
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51. Coba jalankan animasi dengan menekan tombol Ctrl dan Enter secara bersamaan.
52. Simpan file dengan hama Kupu-kupu.

53. Selesai sudah animasi siklus hidup kupu-kupu.
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KEGIATAN 10
MEMPUBLISH DAN MENGEKSPOR FILE

TUJUAN

Setelah mengikuti kegiatan belajar ini, Anda diharapkan dapat:

e mempublish file flash ke berbagai format lain.

e mengekspor image dan movie file flash ke format lain.

URAIAN MATERI

Adobe Flash CS3 Professional mempunyai kemampuan untuk mengekspor/mempublish file ke format

lain, dengan tujuan agar hasilnya dapat dijalankan tanpa tergantung software flash atau dapat

diintegrasikan dengan software lain.
A. Mempublish file
1. Buka file yang akan di publish (sebagai contoh file kupu-kupu).

2.

Pilih File > Publish Settings

Pada jendela dialog yang muncul pilih:

>

Flash (.swf) apabila ingin mempublish file
yang berjalan dengan menggunakan flash
player. File ini dapat digunakan untuk
diupload ke internet.

HTML (.html) apabila ingin mempublish file
dalam bentuk html. File ini dapat digunakan
untuk diupload ke internet.

Gif Image (.gif) apabila ingin mempublish
file dalam bentuk animasi gif. File ini dapat
digunakan untuk diupload ke internet.

JPEG Image (.jpg) apabila ingin
mempublish'  file  dalam bentuk file
image/gambar dengan format JPEG. File ini
dapat .digunakan untuk diupload ke
internet.

PNG(.png) apabila ingin mempublish file
dalam bentuk image/gambar dengan
format PNG. File ini dapat digunakan untuk

diupload ke internet.

Windows Projector (.exe) apabila ingin mempublish file yang dapat berjalan sendiri

(standalone).
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-
Publish Settings

. Farmats Flash

Type:
V| Flash (.swf)

HTML (.hitml)

GIF Image (.gif)

JPEG Image {.jpa)

PMG Image {.png)

Windows Projector {.exe)
Macintosh Projector

QuickTime with Flash Track (.mov)

File:

Latihan 8.swf
Latihan 8.html
Latihan &.gif

Lathan 8.jpg

Latihan &.png
Latihan 8.exe
Latihan 8.app

Latihan 8.mov

-+ =8

TTTTT T T[T

Use Default Names

[ Publish

Il [ ox

] | Cancel
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» Macintosh Projector apabila ingin mempublish file yang dapat berjalan sendiri (standalone) di
komputer Macintosh.
> QuickTime (.mov) apabila ingin mempublish file dalam bentuk movie yang berjalan dengan

menggunakan QuickTime player.

Setelah memilih format file (untuk latihan ini pilih Flash (.swf) ), selanjutnya menentukan nama
dan lokasi penyimpanannya.
1. Pilih Ikon B yang terdapat di samping tipe format file yang dipilih.

Pada jendela dialog yang muncul isikan nama file pada kolom File name. Untuk lokasi

penyimpanan, pilih Browse Folders, kemudian tentukan direktori foldernya.

Select Publish Destination et e
S [ 1 « Modul Pelatinan + File Latihan v|¢,|| Search Eils Latihan P
Organize v New folder i - (7]
Bames * latihan?
File name:  [SUlEGE -
Save as type: |F|ash Player (*.swf) v|
“ Hide Folders Save l | Cancel |
. i
2. Pilih Save.
3. Pilih Publish.
4. Pilih OK.

. Mengekspor File
Selain menggunakan fasilitas publish, Adobe Flash CS3 Professional juga menyediakan fungsi
export untuk mengirim file ke dalam format lain. Fungsi export hanya dapat mengirim file kedalam
file image/gambar dan movie saja, tidak dapat mengirim file ke dalam format .exe (standalone).
B.1. Untuk menggunakan fungsi export image:
1. Klik mouse pada bagian frame yang akan diexport. Pilih File > Export > Export Image
Pada jendela dialog Export Image yang muncul berikan nama filenya, serta pilih format
file yang diinginkan. Untuk lokasi penyimpanan, pilih Browse Folders, kemudian tentukan

direktori foldernya.
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@ Export Image @

Save in: ) File Latihan - @ ? ¥ [

Mo items match your search.

L
N
Recent Places

Desktop

=
Libraries
LY

Computer

“w
Metwork

File name: Latihan 8png -

Save as type: [PNG ("png}) v] [ Cancel ]
Flash Movie (" .awf) | ——

2. Pilih Save.

B.2. Untuk menggunakan fungsi export movie:
1. Pilih File > Export > Export Movie
Pada jendela dialog Export Movie yang muncul berikan nama filenya, serta pilih format
file yang diinginkan. Untuk lokasi penyimpanan, pilih Browse Folders, kemudian tentukan

direktori foldernya.

@ Export Movie @

Save in: | File Latihan - 02 B~
= ¥ Latihan 7
e b % Latihan &

Recent Places

Desktop

=
Libraries
§ |
LY
Computer
@
Metwork

File name: Latihan & -
Save as type: Flash Mavie (".swf) - Cancel

Flash Movis ——

2. Pilih Save.
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